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第一章 产品介绍 

1.1 概述 

VD 系列 VoIP 语音卡是一种采用 PCI 总线的 Sip 协议语音卡，该系列语音卡包含 8路、

16 路、32 路、64 路、120 路五款产品，是维卡科技最新推出的数字化、智能化、大容量、

高密度 Sip 协议语音板卡，整款板卡采用全 DSP 结构，可靠的防雷电路及抗干扰多层专用集

成电路设计，使板卡性能稳定可靠，功能配置灵活简单，信号处理能力强大，便于用户构建

多功能、性能稳定的应用系统。 

维卡公司 VOIP 卡按用途可分为中继和坐席两种应用模式。 

当采用中继模式时， VoIP 通道相当于外线通道，板卡可与 VoIP 网络对接，并提供了

开发 VoIP 应用所需的大部分服务。如编码、发送、解析和接收 SIP 消息，管理板卡通道

和 IP 会话，接收和发送 IP 链路上的语音数据，以及对语音进行编解码并将其传输到 

CT-BUS 总线上等。其应用范围涵盖：IP 网关，媒体服务器/会议服务器，软交换系统，IP PBX 

系统，IP 呼叫中心系统，IP 应用服务器，IVR 系统，大容量的 IAD（综合接入）设备，VolP 

解决方案，NGN 组网支撑设备。  

坐席模式是应市场需求而开发的 VoIP 板卡的一种新的应用模式，主要解决客户在用板

卡搭建分布式呼叫中心时，需要另外购置第三方 sip 服务器且功能受限的问题。公司自主研

发了可以配合板卡使用的 Sip 服务器（VSipServer），此服务器可以实现传统 sip 服务器的

大多数功能，与板卡驱动坐席模块配合使用时，用户即可开发出自己的分布式呼叫中心，并

利用其搭建一个软交换平台。 

1.2 功能描述  

1. 单卡具有 8/16/32/64/120 路通道处理能力。 

2. 通话中可动态改变编解码格式、通话音量调节、录放音以及通话/静音检测等功

能。 

3. 多种方式实现 DTMF 信号的发送与检测，如 SIP-INFO（信令）、RFC2833（带外）

以及带内等。 
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4. 通道的录放音完全独立，可进行单路和多路录放音，具有自动增益功能。 

5. 设有标准 H.100 总线接口，并兼容 MVIP、SC 和 ST，方便与支持的该标准的板卡

交换数据。 

6. 支持电话会议，会议数量和与会人员没有限制。  

7. 具有硬件授权号识别电路，每片语音卡上的固件中均写入了唯一的维卡硬件序列

号，可用于区分不同的卡和防伪识别，应用系统通过简单的函数调用即可获得具

有硬件授权号识别电路，用户可向本公司申请唯一的授权号，保护用户软件安全。 

1.3 特点 

1.  支持 PCI2.1 总线：支持符合 PCI2.1 标准总线，插槽电压支持 3.3V/5V，突发

数据传送速率高达 132 MB/s。 

2.  PCI 总线技术：采用基于 PCI 总线的 DMA 技术进行数据读写，大幅降低了计算机

CPU 的占用率。 

3.  支持多种编程模式：驱动支持应用程序轮询、事件回调、WINDOWS 消息三种编程

模式。 

4.  支持多种录/放音编解码格式 ：支持硬件处理的 A-Law、G.SM、 μ -Law、IMA-ADPCM 

格式的编解码，以及软件处理的 16-bit linear PCM、MP3 格式的编解码，支持

WINDOWS 标准的 WAV 文件，录制的语音文件可以通过 Cooledit 等声音工具进行

编辑和播放。  

5.  支持多种 IP 语音编解码格式： VD 32IP 语音卡支持的 IP 语音编解码格式包括

G.711 A-Law、G.711 µ-Law 和 GSM。  

6.  Barge in  功能 ：支持语音打断 Barge in 功能。  

7.  信号音检测器 ：可配置的信号音检测器，能检测任意频率的单/双音频信号音。 

8.  高效实时的呼叫控制和语音处理 ：该型号板卡为用户提供了高效的呼叫控制、呼

叫管理和语音处理等功能，集成在板卡上的多片语音处理 DSP 可使用户获得近乎

实时的语音效果。  

9.  丰富的 API 函数 ：VD 系列 IP语音卡提供统一的维卡 API 接口，它隐藏了驱动

中硬件通信的复杂性，适合快速开发应用，并将通信协议栈暴露给开发者，以便

根据应用的需求来控制和定制通信流程。  
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10.  统一的维卡驱动软件：具有自主知识产权的维卡语音卡驱动程序开发平台具有高

度的统一性，用户可以简单地调用维卡语音卡驱动程序开发平台的函数来实现电

话呼叫过程中的语音处理，无须您过多了解电话呼叫的细节；能够自动完成数字

中继线外拔电话的全过程，并正确识别被叫用户的状态。 

1.4 软件体系 

 

维卡驱动层：  

    提供维卡语音卡产品统一的编程接口，管理和呈现 IP 通道的状态机，管理并控制 

IP 呼叫流程以及驱动 DSP 处理语音数据等操作。  

维卡 VoIP 系列语音卡协议栈层：  

    包含多个组件，负责实现信令协议、信令控制与传输、媒体传输与管理等任务。

各组件作用如下：  

 信令适配层：负责将信令消息反馈给 TvcDrv 层；  

 SIP Stack ：处理与 SIP 相关的信令消息，以及解析和编码 SDP 内容。  

 RTP/RTCP Stack：负责发送和接收 RTP 和 RTCP 数据包。与 RFC1889/1890、
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RFC3550/3551 标准兼容；  

 DSP Services：使用板载 DSP 处理语音数据。 

1.5 支持的 SIP 标准及其应用  

⑴  VoIP 系列语音卡支持的 SIP 标准  

 IETF RFC 3550 and 3551 (RTP/RTCP)  

 IETF RFC 3265 (SIP Specific Event Notification)  

 IETF RFC 3266 (Support for IPv6 in Session Description Protocol 

(SDP))  

 IETF RFC 2327 (SDP–Session Description Protocol) 

 IETF RFC 3261 (SIP: Session Initiation Protocol)  

 IETF RFC 3262 (Reliability of Provisional Responses in Session   

Initiation Protocol (SIP))  

 IETF RFC 3263 (Locating SIP Servers)  

 IET RFC 3264 (An Offer/Answer Model with Session Description  

Protocol (SDP))   

 IETF RFC 2833 (DTMF)  

 部分 SIP 扩展草案以及 XCAP 协议支持  

⑵  VoIP 系列语音卡 SIP 协议栈特性  

 信令可在 UDP 上进行传输  

 支持摘要认证(Digest Authentication)  

 支持 INVITE、reINVITE 呼叫过程  

 支持 183 响应(铃声回放回送)  

 支持 MESSAGE 、PRACK、UPDATE、INFO 等消息  

 支持 REFER(呼转)消息  

 支持 SUBSCRIBE-NOTIFY(SIP Events)消息  

 支持部分 SIP-T 标准  

 支持 REGISTER 消息以及认证过程  

 支持消息携带多部分 MIME 内容(Multi-Part MIME Bodies)  
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 支持与 SIP 服务器通讯的特性 

 支持呼叫保持  

 支持 DNS 查询(SRV 属性支持)  

 支持会话的状态监控(Session Timer)  

 智能的 URL Scheme 解析机制  

 支持 VIA 域的 rPort 设定(用于 NAT/FW 的穿透)  

 动态 VIA 域控制  

 支持以带内/SIP-INFO/带外（RFC2833）方式接收和发送 DTMF  

 内部多线程机制  

 可启动多个 SIP 协议栈实例共同工作  

 支持动态地址选择方式  

 支持 UDP 心跳保持机制  

⑶  使用 SIP 协议栈进行高级编程：维卡的 SIP 协议栈提供了底层的编程接口，     

些接口以 ANSI C 风格导出，为用户提供了一种可选的开发方式。这些接口被

划分为以下几层： 

 SIP 消息层：创建、编辑和比较 SIP 消息及消息体的各个部分 

 SIP 会话层：控制、管理和销毁 SIP 呼叫，订阅，注册  

 SIP 事务层：处理事务状态机，并触发相应的事件或回调函数  

 SIP 传输层：定义发送请求和接受应答的方式 

 SIP 管理层：设置系统配置与日志，分配内存及其他一些资源  
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第二章 系统布局 

2.1 中继模式系统布局 

 

交换机

坐席卡
中继线语音

卡
Voip卡

PC平台及相关软件

坐席 软电话 Sip话机坐席

E1或模拟

中继

软交换平台

Sip服务器

 

2.2 坐席模式系统布局 

交换机

坐席卡
中继线语音

卡
Voip卡

用户应用程序

坐席
软电话Sip话机

坐席

E1或模拟

中继

Sip坐席模块
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2.3 基本处理流程 

2.3.1 注册流程： 

2.3.1.1 中继模式 

Drv驱动 Sip服务器

Regester(1)
TvcChRegistersip/

TvcBoardRegistersip

401 Authenticate(2)

Regester(3)

200 OK(4)

TvcSipGetChRegStatus：断线/

TvcGetChState：断线

TvcSipGetChRegStatus：空闲/

TvcGetChState：空闲

2.3.1.2 坐席模式 

Sip客户端 VSipServer Drv驱动

Register(1)

注册消息200 OK(2)

TvcGetChState：断线

TvcGetChState：空闲
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2.3.2 基本呼叫建立过程 

2.3.2.1 中继模式 

Drv驱动 Sip服务器 Sip客户端

TvcGetChState：空闲

TvcDialOut：外拨 Invite（1）
Invite（2）

100 Trying（3）

100 Trying（4）

180 Ringing（5）

180 Ringing（6）TvcGetChState：回铃

200 OK（7） 摘机

200 OK（8）

ACK（9）
ACK（10）

TvcGetChState：通话

 

Sip客户端 Sip服务器 Drv驱动

TvcGetChState：空闲

Invite（1）

Invite（2）

100 Trying（3）

100 Trying（4）

180 Ringing（5）

180 Ringing（6）

200 OK（7）

200 OK（8）

ACK（9）

ACK（10）

TvcGetChState：振铃

TvcPickUp：摘机

TvcGetChState：通话

通话
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2.3.2.2 坐席模式 

Drv驱动 VSipServer Sip客户端

TvcGetChState：空闲

TvcStartRing：振铃 呼叫消息 Invite（1）

100 Trying（2）

180 Ringing（3）

200 OK（4） 摘机摘机消息TvcGetChState：摘机

 

注：上图中当调用驱动 TvcStartRing 函数时，通道不一定进入振铃状态，若在 TvcVoip.ini 

下的[SipUser]下配置了 SipUserStyle=1 此配置项时，才进入振铃状态，否则即便调用

了 TvcStartRing 函数，通道仍为空闲状态。 

Sip客户端 VSipServer Drv驱动

Invite（1）

100 Trying（2）

180 Ringing（3）

200 OK（4）

ACK（5）

ACK（6）

呼叫消息

TvcGetChState：空闲

TvcGetChState：摘机

通话
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2.3.3 正常呼叫释放过程 

2.3.3.1 中继模式 

Drv驱动 Sip服务器 Sip客户端

通话（1）

TvcHangUp：通话 Bye（2）

Bye（3）

200 OK（4）

200 OK（5）

TvcGetChState：空闲

 

Sip客户端 Sip服务器 Drv驱动

通话（1）

Bye（2）
Bye（3）

200 OK（4）

200 OK（5）

TvcGetChState：等待挂机

TvcHangUp：空闲

TvcGetChState：通话
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2.3.3.2 坐席模式 

Drv驱动 VSipServer Sip客户端

通话（1）

TvcHangUp：摘机 Bye（2）挂断消息

200 OK（3）

TvcGetChState：空闲

 

Sip客户端 VSipServer Drv驱动

通话（1）

Bye（2）

200 OK（3）

挂断消息（4）

TvcGetChState：摘机

TvcGetChState：空闲

 

第三章 安装配置说明 

3.1 系统要求  

①  系统主机要求：  

       CPU：300MHz Intel® Pentium® Ⅱ或更高。  

       内存：256M 字节或更多。  

       硬盘：视应用系统的实际需求而定。   
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② 支持的操作系统：  

       Windows 操作系统：包括 2000/2003/XP  

3.2 安装步骤  

第一步：关掉待安装微机所有电源，，将硬件配置好的卡装进空闲的 PCI 槽位，并用

螺丝固定好档板。 

    注意：  

    ① 配套使用的其它维卡语音卡产品的安装可参照其硬件说明书。  

    ② 用于组建完整的 VoIP 应用环境所需的必不可少的其它硬件设备（如网卡与网  

       线、IP 电话等）的连接，用户需自行安装妥当。  

第二步：用总线电缆连接各块卡的 H.100 总线接口。  

        通过 CT-BUS 总线，IP 卡与配套使用的其它语音卡间可方便地进行语音数据

交换。  

第三步：开机并安装驱动程序。  

        关于如何安装驱动程序，请参考《维卡程序员手册》。  

第四步：配置 IP 卡的工作参数。  

        具体配置方法请参见《维卡程序员手册》中的有关说明。  

特别注意：  

由于应用系统通常在无人操作的情况下长时间运行，因此必须关闭 CMOS 和                                   

WINDOWS 操作系统中的电源管理中有关 CPU 和硬盘等省电的选项，使微机始

终处于不间断运行状态。否则运行一段时间后，可能会出现性能下降或发生意

外错误的情况。  

按照电信设备使用的常规要求，安装了电话语音卡的微机外壳必须可靠接地，

通常用电源插头的第三只脚即可，但必须确保插座可靠接地。如果不接地，或

接地不可靠，都可能引起电话语音卡工作不稳定且抗雷击能力降低等情况。 

3.3 中继模式用户配置 

1. 正确安装板卡之后，打开计算机，安装驱动程序，安装方法请参考《维卡程序员手
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册》 ； 

2. 开始->运行，输入 tvcconfig，打开配置程序，点击左侧的 VOIP 配置； 

 

 

3. 板卡服务配置，按实际情况配置填写； 

 

4. 编解码类型配置，右侧框体内为支持的编码格式，点击添加到左侧框内，选择板卡

要使用的编码格式； 

 

 
 

5. 板卡注册，即整张板卡注册为同一个账号，其中心跳间隔为检测所注册账号是否依

然有效的间隔时间； 
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6. 通道注册，按通道注册是应先选择上图中注册模式项中的“通道注册”项，其中用

户名增长幅度和密码增长幅度是为方便快速注册设计，例如，按图中配置注册，则

0通道注册的账号密码分别为 1000 和 abcdefg，1通道注册的账号密码则为 1001 和

abcdefh，依次类推； 

 

 

3.4 坐席模式用户配置 

3.4.1 配置文件修改 

配置前先确保已安装 Vcard voip 板卡及驱动，以及 VSipServer 服务器 

安装完成后需修改 c:\windows\System32 下的配置文件 tvcvoip.ini 

Sip 坐席模块配置文件 Config.ini 共两个个文件 

(1) tvcvoip.ini 

需增加[SipUser]节点，此节点下各配置项为： 

Server：sip 坐席模块所使用的 ip地址 

Port：sip 坐席模块所使用的端口，默认即可无需修改 

SipUserStyle：表示是否启用振铃状态，当配置为 1时，表示启用振铃状态。默认不启
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用。 

IsUseFlashDef：自定义 flash 按键开关 1 开启 0 不开启 默认不开启 

FlashStr：自定义 flash 字符串，当 sip 坐席按下此键字符串时表示一次 flash 发生。 

FirstChInSys：sip 坐席通道在系统通道中的起始通道号。 

Channel：需要注册为 sip 坐席模块的通道的范围 

User 通道号:该通道所对应的 sip 话机或软电话的注册号，将通道与注册号绑定 

配置举例： 

用户装了一张 VD16S 模拟卡，一张 32 路 voip 卡。Tvctest 中前 16 路为模拟通道，第

16 路为 voip 通道，需要将 voip 的第 1-5 路配为模拟坐席通道，VSipServer 服务器的

ip 地址为 192.168.0.24 则配置为； 

Server=192.168.0.24  

Port=32135 //默认可不配置 

FirstChInSys=16   

channel=0-4 

User0=100  

User1=101 

User2=102 

User3=103 

User4=104 

(2) Config.ini 

在开始菜单中找到 VSipServer 项，点击 Config。 

 

或在 sip 坐席模块的安装目录下找到 Config.Ini.(默认安装于 c:\VSipServer\),其配

置项中  

[System]节点用于基本配置 

ServerIp: sip 坐席模块使用的 ip地址（所在机器的 ip地址）需修改 

ServerPort: sip 坐席模块使用的端口号，默认即可无需修改 

RtpPortBegin:语音卡传输 rtp 语音数据时所使用的起始端口号，默认即可 
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RtpPortEnd:语音卡传输 rtp 语音数据时所使用的最大端口号，默认即可 

IsWaitToAccept:sip 呼出时是否等待对方摘机后再建立联系，默认即可 

LogLevel：SipServer 日志级别 STACK|DEBUG|INFO|WARNING|ERR|NONE，默认 IFNO，无

需修改。 

[Media]节点用于配置 sip 坐席模块接受的编码格式及顺序，默认即可，无需修改 

常用的编码格式 

0 pcmu u 率，较常用 

3 gsm 一般用于电话 

96 amr 一般用于手机 

8 pcma a 率 

18 g729 

101 telephone-event 电话事件 

3.5 用户操作 

启动 sip 坐席模块 VSipserver 服务器 

（1）dos 监控版本 

点击桌面 ，出现如图 

 

在底下任务日志状况显示框中的记录一栏中显示 be restarted，表示启动成功， 

可最小后隐藏于系统右下角。  
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3.5.1 测试 

打开 c:\window 下 tvctest 程序 

 

若配置正确在配置文件 tvcvoip.ini 中配置的通道将由 ip 通道变为模拟坐席通道 

若 sip 话机或软电话成功注册到 sip 坐席模块，此通道将变成空闲 

 

此时即可对此通道对应的 sip 话机或软电话进行操作了，可以用测试程序中自带的函数 

进行测试，如可对其进行振铃，挂断等操作。 

选中通道 
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对此通道振铃，客户端摘机后 
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若此时挂断，通道又变为空闲状态。 

第四章  抓包工具的使用 

4.1 什么是 Wireshark 

   Wireshark 是网络包分析工具。网络包分析工具的主要作用是尝试捕获网络包， 并尝试

显示包的尽可能详细的情况。 

下面是 Wireshark 一些应用的举例： 

 网络管理员用来解决网络问题 

 网络安全工程师用来检测安全隐患 

 开发人员用来测试协议执行情况 

 用来学习网络协议 

除了上面提到的，Wireshark 还可以用在其它许多场合。 

4.2 特性 

 在接口实时捕捉包 

 能详细显示包的详细协议信息  
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 可以打开/保存捕捉的包 

 可以导入导出其他捕捉程序支持的包数据格式 

 可以通过多种方式过滤包 

 多种方式查找包 

 通过过滤以多种色彩显示包 

4.3 Wireshark 的使用 

数据包的抓取 

1、打开 wireshark 抓包工具，其初始界面如下。 

 
2、点击 Capture->Interface 菜单，如下 

 

3、出现选择界面。此界面会列出本地计算机上的所有网卡，点击需要抓取的网卡（可根据

ip 地址判断）右面的 Start 按钮 

 

4、出现如下界面后，点击 Continu without Saving 按钮。 
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5、此时 wireshark 开始抓取网络包，可根据实际情况对网路包进行过滤。如下图红色区域 

在输入框区域内输入 sip（若要抓取其它协议的包可输入相应的名称，如 rtp），然后点击

最右侧的 Apply 按钮，此时 wireshark 将只显示抓到的 sip 协议包 

 

6、若要保存抓到的网络包，点击工具栏上的停止按钮，如下图 

 

7、然后选择 File->Save 菜单 
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8.出现如下界面，输入要保存的文件名称，即可将抓取的网络包保存到文件中。 

 

   数据包分析 

1、以抓到的网络 rtp 包分析为例。打开保存的抓包文件,其界面如下 

 

 



 

                                                      技术支持热线：0571-568660017 

- 26 - 

 

图 主窗口界面 

2、若抓包工具中没有将 rtp包识别出来，即对指定 ip地址（如本例中 123的服务器）的 protocol

项为 udp 没有识别为 rtp，即需要执行此步，右击某一包，后出现下对话框，按图示选择。 

若抓包工具可识别 rtp 包可跳过此步(这里可以看到抓包工具已识别为 rtp 的 pcma(a 率)编

码）。 

 

3、按图选择 Telephony—rtp—Show All Streams 
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4、出现如下对话框，这里有四项。分别为 123 服务器传给 126 客户端的所有 rtp 包（rtp 包

用于传输声音）。123 服务器传给 127 客户端的所有 rtp 包，126 客户端传给 123 服务器

的所有 rtp 包，127 客户端传给 123 服务器的所有 rtp 包。选中第一项。（如下图 4.4 所示） 

 

5、点击 Analyse 按钮后出现（如下图 4.5 所示） 
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6、点击 Save Payload 按钮，在 name 填写要保存文件的名称。其它默认 

 

7、用 cooledit 软件分析声音 打开刚才保存的文件，安如下进行设置后 ok 

 

图 4.7.1 
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图 4.7.2 

 8、播放声音文件可以看出服务器所发出的 rtp 包是否正常。 

 

图 4.8 
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第五章 常见故障及处理思路 

5.1 SIP 终端注册类问题 

【问题现象】 

1） SIP 平台上 SIP 信令跟踪看不到 Voip 终端注册请求，SIP 终端注册超时 

2） SIP 平台对终端注册请求回复 423 消息 

3） 请详细描述其他现象 

【处理思路】 

该类问题一般与配置有关： 

1） 路由：SIP 终端与 SIP 平台之间的网络不通，可通过 ping 命令查看 sip 服务器与 sip

客户端之间的网络是否畅通。可通过 telnet 命令查看 Sip 服务器的服务端口（5060）

是否开启。 

中继模式时：Voip 卡注册服务器的 IP 地址配置出错，导致注册信息无法到达 SIP 平台，

注册超时。请先检查 TvcVoip.ini 中[System]下 LocalSipIp（本地 ip 地址） Gatewa 

（网关地址）的配置 

（1）板卡注册时：请检查 TvcVoip.ini 中[System]下 RegSipServer（注册服务器地址） 

UserName（用户名） RegPassword（密码）的配置是否正确 

（2）通道注册时：请检查 TvcVoip.ini 中[ChRegGroup0]下 ServerIp（注册服务器地址） 

user（用户名） pwd（密码）的配置是否正确 

坐席模式时；请检查客户端服务器地址的配置。 

2） 注册时长：终端期望的注册时长小于 SIP 平台上配置的最小注册时长，SIP 平台发送 423

拒绝请求 

中继模式时：检查 TvcVoip.ini 中[System] 下 RegExpires 的是否为 0，若为 0请改为

3600 

5.2  SIP 基本呼叫类问题 

【问题现象】 
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1） SIP 平台拒绝主叫的 INVITE 呼叫请求 

2） 被叫拒绝 SIP 平台的呼叫请求 

3） 被叫正常振铃，被叫摘机，呼叫马上释放； 

4） 通话一段时间之后，SIP 平台主动释放呼叫 

5） 请详细描述其他现象 

【处理思路】 

1） 主叫发起的呼叫是否合法，如主叫用户是否已经注册 

中继模式：请检查通道状态是否为空闲，通道用户名密码是否正确。 

坐席模式：请检查用户是否在配置中已绑定 

检查 TvcVoip.ini 中[SipUser]下 User？是否已绑定用户到通道。 

2） 媒体协商是否成功。呼叫建立时，主被叫必须完成媒体协商 

打开 TvcConfig 在 Voip 配置中查看支持编码类型一栏，检查所支持的编码是否与 

客户端或 Sip 服务平台的相匹配。 

3） 用户是否没有及时发送注册信息刷新注册状态。 

4） SIP 信令是否符合协议 

5.3 SIP 呼叫单通或双不通类问题 

【问题现象】 

1） 主叫用户可以听到看到被叫用户，但被叫用户无法听到看到主叫用户 

2） 主叫用户无法听到看到被叫用户，但被叫用户可以听到看到主叫用户 

3） 主叫用户无法听到看到被叫用户，且被叫用户无法听到看到主叫用户 

4） 请详细描述其他现象 

【处理思路】 

1） 终端之间的网络是否畅通，也就是 RTP 流是否可以顺利到达对方 

2） RTP 流编解码是否与主被叫协商成功的编解码一致 

3） RTP 流发送的目的 IP 地址和端口是否与信令协商结果一致 

4） 双方 RTP 流打包时长是否一致 

5） 终端是否接受远端采用不同端口收发的 RTP 流 

6） 是否有一方发送了静音包，表现为 RTP 流二进制报文很有规律 
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7） RTP 流的端口是否为偶数，RTCP 端口是否为 RTP 端口＋1 

【配置检查】 

1） 确保网络畅通，互 ping 对端的 IP 地址测试； 

2） 在距离主叫侧用户终端最近的网络位置，抓取主叫侧的 RTP 流，可以分析主叫用户采

用的编解码、发送的目的 IP 地址和端口、打包时长、是否接收到被叫语音流等信息 

3） 在距离被叫侧用户终端最近的网络位置，使用 ethereal 等工具抓取被叫侧的 RTP 流。 

【反馈信息】 

1） SIP 信令跟踪消息和主被叫用户内部模块间接口跟踪消息 

2） 如果呼叫涉及其他协议类型的用户或中继，请同时提供该协议的信令跟踪 

3） 主被叫设备上，执行互 ping 对方 IP 地址的结果 

4） 采用 Ethereal 工具在分别距离主被叫物理位置最近的地方，抓取主被叫侧的 RTP 流； 

5.4  SIP 二次拨号类问题 

【问题现象】 

1） 主叫听到二次拨号提示音后，进行二次拨号没有任何响应 

2） 请详细描述其他现象 

【处理思路】 

该类问题与二次送号能力协商结果或收号设备本身能力有关： 

1） 二次拨号方式有 DTMF 送号和 2833 送号两种方式 

2） DTMF 送号方式不需要通过 SIP 进行协商 

3） SIP 二次拨号问题主要关注 2833 送号方式是否协商成功，至于终端是否能送号、收号

设备是否能正确收号，则需要咨询相关设备的工程师 

【配置检查】 

1） 检查终端和收号设备是否都具备 2833 能力 

2） 检查终端和收号设备是否都具备 DTMF 能力 

3） 采用 ethereal 工具抓取网络报文，可以分析终端是否正确发送二次拨号信息 
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5.5  SIP 消息跟踪丢失类问题 

【问题现象】 

1） 跟踪 SIP 信令时，根据 IP地址进行过虑，发现 SIP 消息随机丢失 

2） 跟踪 SIP 信令时，根据 IP地址进行过虑，发现 SIP 消息有规律的丢失 

【处理思路】 

该类问题主要由流控产生，属规格问题： 

1） SIP 消息随机丢失，一般跟大话务量呼叫有关：系统支撑模块会对上报的呼叫信息先流

控后过滤，如果上报的消息超过 128 条/秒（包括其他类型的信令跟踪），就会出现消息

丢失情况 

2） SIP 消息有规律的丢失，一般是有 SIP 代理参与到呼叫建立过程中，但是，这些 SIP 代

理在呼叫建立之后，就会退出后续的呼叫流程而造成 SIP 消息“丢失”的假象 

5.6  SIP 长时间通话断话类问题 

【问题现象】 

1)  请详细描述问题现象 

【处理思路】 

1） 检查是否有人为挂机和网络中断现象 

2） SIP 平台内部模块间检查出现错误释放呼叫，用户内部模块间接口消息比较重要 

3） 用户没有及时注册导致 SIP 平台认为用户离线而释放呼叫 

【配置检查】 

1） 断话时，马上检查用户是否在线 

2） 检查哪一方释放呼叫以及释放时间； 

【反馈信息】 

1） SIP 信令跟踪消息和主被叫用户内部模块间接口跟踪消息 

2） 如果呼叫涉及其他协议类型的用户或中继，请同时提供该类协议的信令跟踪 
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附录 

附录 1 性能参数 

·外形尺寸：长×宽＝306×106mm（不含固定片） 

·重量：约 380 克  

·最大消耗功率：≤15W 

·工作温度：0℃-60℃  

·储存温度：-15℃-60℃  

·频率响应：350-3500HZ（±3dB）  

·录放音失真度：≤2％  

·湿度：10％-70％  

·帧结构：CCITT G.704-1988(CRC4) 

·防雷击能力：4级  

·语音编码格式：G.711 a-law、G.711 mu-law、GSM、amr、g729 

·常用音频编解码速率： 

A-Law 64kbps 

μ -Law  64kbps  

G.729 8kbps  

AMR 12.2kbps  

 

附录 2 MSS 配置 

1.安装 miniSipServer ，启动程序； 
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2.设定 SIP 服务器； 

 

3.添加本地帐号：”Data->Local users->add”,在“User information”中的 BaSic”

标签中添加本地用户，本例中：MSS 添加 100，101，用户名与密码相同，另外两项

选填； 
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4.设定 MSS 的 MSS Trunk 端口：”Data->System information”,在 MSS Trunk 标签中

输入“signal port 与 IP relay start port，本例中使用默认配置 
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附录 3 网络电话配置（以 Xlite 为例） 

安装 Xlite 并开始运行它，它会提示配置一个 SIP帐号： 

点击 Add 添加一个 Sip帐户，如下图： 
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关键的配置描叙为： 

点击"OK"完成 Xlite 的配置。Xlite 会试着注册到 Sip 服务器.如果成功，它应该显示

"Ready"信息 
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附录 4 SIP 介绍 

1 概念 

SIP（Session Initiation Protocol，会话发起协议） 是由 IETF（Interne 工程任务

组）提出的 IP 电话信令协议。它的主要目的是为了解决 IP 网中的信令控制，以及同

SoftSwitch(软交换)的通信，从而构成下一代的增值业务平台，对电信，银行，金融等行业

提供更好的增值业务。 

SIP 是一种应用层控制协议，用于在 IP 网上建立、修改以及终止多媒体会话或呼叫，

现由 SIP 工作组负责，参考规范 RFC2543。目前主要用于多媒体会议、远程学习、IP电话等

等。 

2 SIP 的基本功能 

1.用户定位（User location）－ 决定哪个终端系统参加通信 

2.用户能力（User capabilities）－ 决定通信所采用的媒体和媒体参数 

3.用户可用性（User availability）－ 决定被叫方是否愿意加入通信过程 

4.呼叫建立（Call setup）－ 振铃、主叫方和被叫方的连接和参数的建立 

5.呼叫处理（Call handing）－ 呼叫转移、终止呼叫等 

3 SIP 主要特征 

1.SIP 可以发起会话，也可以邀请用户加入以其它方式(如 SAP、LDAP 等)发布或建立的会话；

通过 SDP 协议，SIP 可以在呼叫发起和呼叫进行过程对会话参数进行协商，如会话带宽要

求、传输的媒体类型（语音、视频和数据等）、媒体的编解码格式、对组播和单播的支持

等。 SIP 可以提供呼叫控制功能（如呼叫保持、呼叫路由、呼叫转移、媒体转换等） 

2.SIP 可以支持单播会话，也可以支持多播会话； 

3.SIP 与网络协议独立，即与底层协议无关（Lower-Layer-Protocol Neutral）。SIP 可以在

不同的传输层协议上工作，如 TCP 或 UDP。当使用 UDP 的时候，SIP 可以更好的支持多播

会话；当使用 TCP 的时候，SIP 可以更容易的通过防火墙。 

4.SIP 支持很多其他协议，如 RSVP、RTP 和 RTCP、RTSP、SAP、SDP 等。但是，SIP 的功能和
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操作不取决于以上任何协议。 

5.SIP 是基于文本的协议, 简单灵活,可扩展性好； SIP 采用 Client/Server 的体系结构，

在很大程度上继承了 HTTP 和 SMTP 协议的特征。 

6.SIP 协议是无状态的（Minimal State），服务器可以保持也可以不保持呼叫状态； 

7.SIP 透明支持名字映射和重定向服务，可以实现 ISDN 和 IN 电话用户服务； 通过网关，

SIP 可以实现 PSTN 电话之间的呼叫。 

8.SIP 支持用户的移动性和移动业务。 

4 SIP 地址  

   SIP Addressing  SIP 地址格式由 SIP URL（SIP 统一资源定位器）定义， SIP URL 类

似于 mailto 或 telnet URL。SIP 在设计上充分考虑了对其他协议的扩展适应性。它支持许

多种地址描述和寻址，包括： 用户名＠主机地址、被叫号码＠PSTN 网关地址和如 Tel：

010-6228****这样普通电话号码的描述等。SIP 地址包括用户部分和主机部分，如：

j.doe@big.com j.doe@192.168.10.1；可以用来标识一个人、一个组里第一个可以访问的人、

或者标识一个组。  SIP 地址可以从带外信息获得（如媒体代理、email 等）。 

5 SIP 组件   

1.体系结构   

SIP 是基于客户机／服务器结构的。基本分为用户代理和网络服务器。   

用户代理（User Agent ）  

用户代理客户端（User Agent Client） 

用户代理服务器（User Agent Server）   

网路服务器（Network Server） 

   代理服务器（Proxy Server） 

   重定向服务器（Redirector Server）  

   注册服务器（Registrar） 

   位置服务器（Location Server）  

2.基本组件   
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(1)用户代理（User Agent） 

用户代理客户端 UAC（User Agent Client）：发起 SIP 呼叫的客户端应用程序。   

用户代理服务器 UAS（User Agent Server）：接受 SIP 请求的服务器程序。作为用户的

代理，根据接受到的请求代表用户返回相应的响应：接受、拒绝、转接。  用户代理客

户端 UAC 和用户代理服务器 UAS 都可以终止一个呼叫。   

(2)代理服务器（Proxy Server）  

代理服务器是代表其他客户机发起请求，既充当服务器又充当客户机的媒介程序。请求

可能在代理服务器中被服务或者直接经过翻译后发送到其它的服务器。它在转发请求之

前可能解释、改写、翻译原请求消息中的内容。   

(3)重定向服务器（Redirector Server）  重定向服务器在接收 SIP 请求后，把请求中的原

地址映射成零个或多个新地址，返回给客户机。与代理服务器不同的是，重定向服务并

不会发起自己的请求。与用户代理相区别的是，重定向服务并不会发起或中断呼叫。   

(4)注册服务器（Registrar）  注册服务器主要是接收客户机的注册请求，完成用户地址的

注册。注册服务器应该支持用户鉴权。  注册服务器一般配置在代理服务器和重定服务

器之间，并且一般配置位置服务器的功能。   

(5)位置服务器（Location Server）  需要注意的是，位置服务器并不是一个 SIP 服务器，

SIP 服务器可以通过任何非 SIP 协议如（SQL，LDAP，CORBA，etc.）来连接位置服务器。  

位置服务器的主要功能是提供位置查询服务，主要是由代理服务器或重定向服务器用来

查询被叫的可能的地址信息。 

6 SIP 消息  

SIP 消息分为两大类：请求（Request）和 响应（Response），响应又分为最终响应（Final 

Response）和 临时响应（Provisional Response）。  

1.请求消息 请求消息分为 6种：INVITE、ACK、BYE、CANCEL、REGISTER、OPTIONS。  

 (1) INVITE   

INVITE 方法说明一个用户或业务参加一个会话。消息体部分包含了被叫的信息说明。

对于双方呼叫，主叫需说明他能接受和发送的媒质类型。这个消息应该被 SIP 代理服

务器、重定向服务器、用户代理服务器和客户机所支持。  

 (2) ACK   
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ACK 方法主要用于确认客户端对 INVITE 方法的请求已经响应。这个消息应该被 SIP

代理服务器、重定向服务器、用户代理服务器和客户机所支持。  

 (3) BYE   

客户机用 BYE 方法向服务器发消息来结束该呼叫。这个消息应该被 SIP 代理服务器、

重定向服务器、用户代理服务器所支持。  

 (4) CANCEL   

CANCEL 方法用于取消一个挂起的呼叫。这个消息应该被 SIP 代理服务器、重定向服务

器、用户代理服务器和注册服务器所支持。  

 (5) REGISTER   

用于向定位服务器注册客户机的相关信息。  

 (6) OPTIONS   

用于查询服务器的相关信息和功能。这个消息应该被 SIP 代理服务器、重定向服务器、

用户代理服务器和客户机、注册服务器所支持。  

 2.响应消息 响应消息分为 6类：1xx，2xx，3xx，4xx，5xx，6xx。  

 (1) 1xx Informational（通知） 服务器或代理正在执行处理，终端应该等待响应。如果

服务器需要 200 毫秒以上的时间进行处理，则向终端发送 1xx 响应。服务器可以发送

多个 1xx 响应，终端不需发送 ACK 请求。  

 (2) 2xx Successful（成功） 请求成功，停止查询。  

(3) 3xx Redirection（重定向） 3xx 响应给出用户新的位置，或者能够满足呼叫的另一

个服务器，主叫应该终止当前查询，开始新的适当的查询。 任何重定向响应都不能

列出 Via 中的地址，以防止 forwarding loops,同时用户代理或者代理服务器必须检

查从重定向服务器返回的地址，确认与以前尝试过的地址不相同。  

 (4) 4xx Request Failure（请求失败） 4xx 响应定义了服务器的失败响应，客户端不应

该重新发送相同的请求（例如可以加入适当的鉴权）。不过，同样的请求发到其他的

服务器有可能成功。  

 (5) 5xx Server Failure（服务失败） 当服务器本身错误时，返回 5xx 响应。5xx 响应并

不表示最终错误，如果其他的可能的地址还没有尝试过，就不能结束一个查询。  

 (6) 6xx Global Failures（全局错误） 6xx 响应指出这是关于指定的用户的最终信息，

而不仅仅是 Request-URI 中指出的实例请求。（the particular instance indicated 
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in the Request-URI.）所有未来的对该用户的请求都会失败，还未结束的对该用户

的查询都应该中断。 

 


